A Publication of the
Bellarine Mac User Group
http://bellarinemac.org.au

October 2012
Monthly Meeting

Tuesday
October 9th
Starts 4:00 PM

Participants in the Pixelmator SIG are reminded to arrive at 1.30pm to help set up for the session
which will run from 2pm to 3.30pm.
If you are not participating in the Pixelmator SIG, would you please get your coffee on arrival and
take it to the first session. During the break between sessions there will be time for you to wash your
cup and interact with other members.

This Meeting will consist of three workshops1. Workshop for Beginners. 2. Workshop for iPad Beginners 3. Workshop for advanced iPad Users.
Please bring your MacBooks, iPads and questions to ensure productive Sessions.

at
St Peterʼs Hall, corner
Draper and Hodgson
Streets

The first part of the meeting was our Annual General Meeting.
We then had Kylie Branson from the Geelong Regional Library as our Guest Speaker.

Ocean Grove

Kylie discussed and demonstrated a new feature which has recently been introduced by the Library,

All Welcome!

you require access to at least one of the various types of eReaders, which include your iMac, Laptop,

being the availability of E-books for borrowing by Library members. To avail yourself of this service
smart phone, iPod Touch and iPad.
At this stage Kindle readers cannot be used, because they are only licensed to Amazon.
There are approximately 650 books and they can be borrowed for 7 or 14 days.

BMUG offers support to users of Apple Products.
Whether you are a first time user or a hot shot computer programmer, we would like to think that we have something we can offer you,
especially new Tips for each Device. We are simply a group of people who get together once a month to exchange ideas, ask advice,
share knowledge and enjoy each other’s company.
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BMUG is a self help group of Apple users. Naturally the new
members we attract are the people who want to learn to use their
Apple iMac / MacBook / iPad / iPhone with the related Apple
software programs.
A brief questionnaire was handed out at our September meeting
seeking feed back on the members Apple equipment and for
comments on what they wanted to learn. If you would like to
contribute to the survey questionnaire, there is a copy in this
newsletter on page 18. Please e-mail your response for inclusion in
the process to peteroakley@bellarinemac.org.au
It is clear we will not be able to meet all requests, as we only have
one meeting per month. However it could be possible to have a
Discussion Group on a “subject” if there are people willing to meet
elsewhere, such as in a cafe or at a members home.
Another option is that we might advise the location for training
related articles that are on the web. By way of an example 45% of
respondents to date, either have or intend to buy an iPad. The
perfect portable device for a meeting.
Your new committee will study the replies and try to put in place a
meeting schedule that will answer some of the member’s requests.
Happy computing.

Peter Oakley
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Apple Users Society of Melbourne: Major 2012 Raffle.
There are still a few of the $5 raffle tickets available for purchase. The Raffle will be drawn at the AUSOM Meeting on 1st
December at 3pm. It is proposed that some of our Committee Members will attend this Meeting and witness the raffle being
drawn. First Prize: A MacBook Pro 15” - Retina Display, valued at $2,739.00. Second Prize: A Mac Book Air 13” valued at
$1,459.00. Third Prize: A 3rd generation iPad, 32GB, WiFi + Cellular. Our Club receives half the proceeds of our ticket sales.
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We are hoping that at least one Prize will come back to Geelong this year!

Review of the Newsletter:
Your Committee has reviewed the style and content of our Newsletter and believes that the current structure needs to be
modified. It is proposed that in future, the newsletter should act more as a “Call to the next meeting”, and mostly contain
items relating directly to Club activities with a few short articles and links.
You will note that the layout of this Newsletter has been altered to hopefully make it easier to read.
As most of the articles were already composed prior to the Committee Meeting, this will be the last newsletter of of its type
and length.

Closure of Library:
It has been decided to abandon the Library Operation, due mainly to lack of support from members and also because of the
fact that most of the Tutorial type books that we stock seem to go out of date in a very short time. Also, Tutorial material is
easily accessible from the Internet and in many cases it is free.
At the November Meeting we will have an Auction Table for the sale of all library books to members.
In the mean time, we request that members who have not returned books to please do so at this meeting so that they can be
sorted ready for the November Sale.
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The following two Books are still available for purchase:
“Mac Computing for Seniors in easy steps”
One Copy available ($15.00)

“Mac Basics in easy steps”
One Copy available ($15.00)

Note:

A further bulk purchase of these two books
is unlikely in the near future.

This month’s lucky door prize is a 1-month “Core Library Pass”, kindly provided by
macProVideo.com, valued at $25 USD. The Pass provides instant access to macProVideo.com’s
Online Tutorial Library, and it comes in an attractive fold out box.

macProVideo.com is an online education community featuring Tutorial-Videos and training for popular
Audio and Video Applications including Adobe CS, Logic Studio, Final Cut Studio, iLife’11, iWork’09, OS
X Lion, OS X Mountain Lion and many more.
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How to reduce clutter in your Mail Address Book:
I have occasionally looked at my address book and noticed someone’s name, and been unable to figure out
who the person was or where I had received their information. If I no longer recall the person it is unlikely
that their information needs to be in my address book. Similarly, colleagues who I worked with years ago
and whom I have not been in touch with since, should probably not be in my list.
I could manually scan my contact list and delete names that I don’t recognise, but there are better ways to
automate the process.

!

!

!

!

!

!

Mail and Address Book pruning:
In Mail, choose “Window > Previous Recipients” to display the list of
everyone to whom you have sent e-mail. (This list is helpful only in that it
facilitates automatic address completion when sending new messages.
Having addresses you don’t use in here only makes addressing more
awkward.) Contacts who also appear in your Address Book have a small
address card icon next to them.
Click on the “Last Used” column header to sort addressees by how recently
you’ve sent them mail.
Starting from the oldest date, select any recipient to whom you don’t expect
to send mail and click on Remove From List.
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How to Properly Research on the Internet
Legitimate online research involves much more than 10 seconds with Google and copypasting the Wikipedia links.
Legitimate research is called re-search for a reason: repetitive and continuous searching,
filtering, and citing of articles, all with a critical and skeptical mindset to separate the drivel
from the useful content.
There are over 80 billion Web pages published, and most of those pages are not worth quoting.
To successfully sift it all, you must use consistent and reliable filtering methods. You will need
patience to see the full breadth of writing on any single topic. And you will need your critical
thinking skills to disbelieve anything until it is intelligently validated.

The above article is an extract from an article written by Paul Gil and published in
About.com.Guide in August 2012. For the complete article click on the link belowhttp://netforbeginners.about.com/od/navigatingthenet/tp/How-to-Properly-ResearchOnline.htm?nl=1
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Gmail - What is Gmail?
Definition:
Gmail is Google's free web-based email service. Gmail says its email service offers better spam
protection, lots of free mail storage (over 7400 megabytes free at last check) and access via mobile
phones. The free version of Gmail also includes built-in chat capabilities.
The free version of Gmail is ad supported, so when you open an email message in Gmail, you're likely to see ads
related to the topic of that message. If Google doesn't find any ads it considers related to that message, you may
instead see ads related to the last message you opened.
Most users have high praise for Gmail, at least in two areas:
1.

Gmail allows them to set up a free email account they can use for special designated purposes - such as signing
up for things or for handling client work - without worrying that their regular email account will become a
spam target and without identifying themselves with their domain name.

2.

Many have praised its search capabilities in finding stored mail messages.

You don't need a Google account in order to set up Gmail. In fact, Gmail sign up requires just a valid existing email
address and agreement to Google's terms and conditions. Then you can use your Gmail account to log into to other
Google online services, such as AdSense, AdWords or Google Webmaster Tools.
Because Gmail is web-based, whether you like it or not will largely depend on the speed of your Internet connection.
If you have broadband, Gmail can be a good way to handle all or just a portion of your email that will be stored
online where you won't have to worry about losing your messages. The other benefit of using online email services
like Gmail offers is that you can access your email account from anywhere.

For more information about Gmail, click on the link- http://google.about.com/od/emailandchat/fr/gmailrev.htm
!Member Alan McGuire uses Gmail and provided the information for this article.

Peter Baldwin
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How to Monitor Applications in OS X Mountain Lion:
Mountain Lion can monitor the origins of applications you add to your computer and warn you if they might not be what
you prefer. This feature is known as Gatekeeper.
With Gatekeeper, you can choose to run only apps from the App store written by developers registered by Apple, allow App
store apps by unregistered developers, or allow any apps from any source to run. Depending on how Gatekeeper is
configured, you'll see various alerts about the security of apps you add to your computer.
You won't see a GateKeeper Icon in the Finder. In Mountain Lion it is found in “System Preferences > Security”. It appears
as an option which you can select to determine what kinds of applications the Operating System will allow to be installed
and run.

Option 1: Allows only those applications that have been purchased from the Mac App Store. This option may be too
restrictive for most of us.

Option 2: This option is the default, and is probably the one that most users will accept.
It allows applications bought from the Mac App Store or from “Identified Developers”, whose registration with Apple can
assist in the response to any reports of security issues.

Option 3: Apply no restriction at all.
This may be a risky selection when you consider the current security problems .
The question arises as to what happens when you launch an application with which you are very familiar, or which has been
obtained from a source you regard as reliable, but which creates an alert, warning you that it comes from a non-identified
Developer and therefore can't be launched?

The answer is simple and is worth remembering.
Locate the application's Icon (probably in your Applications folder) and Control-click or right-click it. From the contextual
menu choose “Open”. You might be presented with another alert box. Ignore the second warning message and again click
“Open”. The application should then open and run normally.
You will only need to follow the above described procedure once for any affected Application.
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The following Tips are Excerpts from The OS X Mountain Lion Pocket Guide by Jeff Carlson

Back Up Your Data Before Syncing:
Before you enable syncing, make sure your data is backed up. In Contacts, choose “File > Export > Contacts
Archive”. In Calendar, choose “File > Export > Calendar Archive”. Perform this step in addition to any backup
system you have in place, just to be sure.

Upgrading to Mountain Lion? Check Your FileVault:
If you ever used FileVault under Snow Leopard or earlier, turn it off before upgrading to Mountain Lion.
The original FileVault encrypted your Home directory, but the FileVault implementation in Lion and
Mountain Lion is completely different—it encrypts the entire hard disk. Open the Security & Privacy
preference pane, click the FileVault button, and then click the Turn Off FileVault button. You don't need to
do this if you're using FileVault under Lion and upgrading to Mountain Lion from there.

New iPods available in Apple retail stores in October.
iPod touch starts at $299.00 USD.
http://www.apple.com/itunes/new-

A completely redesigned player. A newly
remodelled store. And even more iCloud
features. The new iTunes looks easy,
because it is easy.
9

Get Backup, is available in Freeware and Pro versions from Belight Software. It is a backup software utility
that helps to automate the backup creation process. To unlock the Pro version features, you need to register the
Freeware version with a license code.
Read more about Get Backup.""

"

Buy Get Backup Pro — $19.95

Get Backup Pro is able to create encrypted backups and synchronise folders across multiple computers. It has the
ability to set schedules (for example daily, weekly or monthly), and perform full, incremental or versioned backups.
It’s simple to use and makes the backup process fairly easy.

Get Backup vs. Apple Time Machine
You may wonder why you need an additional backup
software when you already have Apple Time Machine
on your Mac.
Get Backup has multiple advantages when you need to
control what to backup. It offers advanced compression
and encryption methods and much more.
Compare Get Backup with Time Machine.
More features...
Peter Baldwin
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What is Dropbox?
Why You Should Selectively Sync Your Macs with Dropbox
Description:
Dropbox is a free service that lets you take all your photos, docs, and videos anywhere. Any file you
save to your Dropbox is accessible from all your computers, iPhone, iPad and even the Dropbox
Dropbox allows you to create a special folder on each of your computers, which it then synchronises so that it
appears to be the same folder (with the same contents) regardless of the computer it is viewed on.
If you're not already using Dropbox on your Macs and other devices, you should be!
Think about this: Two GB of file storage, plus automatic syncing of your files across your devices is Free.
Convinced? Need more details? Point your browser of choice to the Dropbox website, read the instructions, and
click the big Download Dropbox button when you're ready.
Now, why use selective syncing?
All the files that you store in Dropbox and sync to your Mac take up space on your Mac's hard drive. The downside
is that if you have a small hard drive and lots of storage in your Dropbox. Your Dropbox folder can start eating up a
lot of your Mac's limited storage. Syncing only certain folders can conserve hard drive space. Also, selective-sync
settings are computer-specific. Each of your Macs can selectively sync a different set of folders, if you like.
I mainly use Dropbox to move files between our iMac and iPad. It is also ideal for sending files that are too large for
a normal email transmission. One brilliant feature is the automatic web photo gallery. The default Photos folder has
a special function. You create a sub-folder inside Photos for whatever you want and then put your selected photos
into it. When it is finished uploading (white tick), right click on the folder, go down to Dropbox and click on “Get
Link” from the options. Email the link and the recipient will get a gallery of your photos.
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NOTE: You must be aware that Dropbox may not be a fully secure Application and therefore you must be
careful with your confidential information.
On a Mac, the Dropbox icon appears in the top-right section of the toolbar. Once the file is in Dropbox, the upload
to the cloud starts automatically and it is complete when a white-on-green tick appears under the file icon. It is then
ready for sharing. Open dropbox.com in a browser and the same folder structure appears as on your computer.
Navigate to the file to be shared, right click on it and choose “Get Link”. A window opens, into which you enter an
email address. Dropbox recognises your Address Books, so the address will usually be completed automatically.
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Peter Baldwin

Apple unveils iPhone 5
The new iPhone 5 features a thinner and lighter design, a larger "retina" display
and comes with 4G LTE connectivity that will support the Telstra, Optus and
Virgin Mobile 4G networks in Australia.
Apple received over 2 million orders world wide in the first 24 hours. It
became available in Apple stores from 21st September.
The differences in list price between the USA and Australia is significant. The
16, 32 and 64 GB models are listed in the USA at $US199, $299 and $399.
Australian list prices are $799, $899 and $999 respectively.
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Hands-on learning with the iPad:
Teachers and students at Northwest Kansas Tech find a common touch point.
The introduction of iPad and select apps has opened up many new learning opportunities.
Thanks to AirPlay technology built into the iPad, auto technology students now watch video demonstrations of
repair techniques streamed wirelessly by their instructors from iPad to a large flat-panel display connected to an
Apple TV.
A respiratory therapy instructor uses iPad to highlight lessons in a collaborative textbook app that students can
access in the classroom or from remote labs and clinical sites.
Cosmetology students use an iPad app that lets them comprehensively track and manage clients.
The benefits of the iPad program are visible across the campus.
Students use iPad to access the school’s iTunes U content, to collaborate with teachers and other students, and to
develop their own video learning projects with the built-in iSight camera. Students with low reading, writing, and
math scores use iPad and apps to achieve better learning outcomes. Graduating students use iPad to create digital
portfolios, which they bring to potential employers to demonstrate what they’ve learned and what they can do.

Watch this interesting video and....... Read more… !
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Peter Baldwin
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This Program is available to all members. We will attempt to resolve your urgent Mac problems if we
can, or alternatively give you advice about where to seek further assistance.
Peter Oakley is available to take your call on 0409 094 655.
Margaret Evans is available to advise members new to Macs. Email Margaret with your query and
include your Telephone Number. margaretevans@bellarinemac.org.au
Alternatively you could make a booking for assistance by using the Form on the website or by
contacting Peter Oakley using the email link. Make a Booking with Peter Oakley...
Committee Members (Pink Tags) are available during the coffee break for assistance.
In many cases you may find a solution to your problem by inserting your question in Google. It is
amazing what information you will find.

New Members Welcome
We welcome all Apple/Mac Users. What are you waiting for?
Web: www.bellarinemac.org.au
Visit our Website for Membership Details
OR
Email Secretary, Pat Hollis, for Membership enquiries: Email Pat ...
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See President’s Report on Page Two:
If you did not complete one of the above Forms at our last meeting, and you would like to participate in the
Survey, please email your reply as an answer to the above questions To: peteroakley@bellarinemac.org.au
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Peter Oakley
President,
BMUG Assist.

Margaret Evans
Hall & equipment
Co-ordinator.

Peter Baldwin
Vice-President,
Newsletter Editor,
Web Assist,
Library Co-Ordinator.

Pat Hollis
Secretary,
Membership.

Bev Amey
Meet & Greet,
Membership Assist,
Secretary Assist.

THE COMMITTEE IS ASSISTED BY:

Dick Brown
Currently Leader of the Pixelmator SIG

Ian Little
Treasurer.

Prue Paterson
Web Manager
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